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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.
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Number of LABs/CLBs 2125

Number of Logic Elements/Cells 17000

Total RAM Bits 716800

Number of I/O 116

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 328-LFBGA, CSBGA

Supplier Device Package 328-CSBGA (10x10)
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Figure 2-1. Simplified Block Diagram, LatticeECP3-35 Device (Top Level)

PFU Blocks 
The core of the LatticeECP3 device consists of PFU blocks, which are provided in two forms, the PFU and PFF. 
The PFUs can be programmed to perform Logic, Arithmetic, Distributed RAM and Distributed ROM functions. PFF 
blocks can be programmed to perform Logic, Arithmetic and ROM functions. Except where necessary, the remain-
der of this data sheet will use the term PFU to refer to both PFU and PFF blocks. 

Each PFU block consists of four interconnected slices numbered 0-3 as shown in Figure 2-2. Each slice contains 
two LUTs. All the interconnections to and from PFU blocks are from routing. There are 50 inputs and 23 outputs 
associated with each PFU block. 
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Note: There is no Bank 4 or Bank 5 in LatticeECP3 devices.
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Figure 2-3. Slice Diagram

Table 2-2. Slice Signal Descriptions

Function Type Signal Names Description 

Input Data signal A0, B0, C0, D0 Inputs to LUT4 

Input Data signal A1, B1, C1, D1 Inputs to LUT4 

Input Multi-purpose M0 Multipurpose Input 

Input Multi-purpose M1 Multipurpose Input 

Input Control signal CE Clock Enable 

Input Control signal LSR Local Set/Reset 

Input Control signal CLK System Clock 

Input Inter-PFU signal FC Fast Carry-in1 

Input Inter-slice signal FXA Intermediate signal to generate LUT6 and LUT7

Input Inter-slice signal FXB Intermediate signal to generate LUT6 and LUT7

Output Data signals F0, F1 LUT4 output register bypass signals 

Output Data signals Q0, Q1 Register outputs 

Output Data signals OFX0 Output of a LUT5 MUX 

Output Data signals OFX1 Output of a LUT6, LUT7, LUT82 MUX depending on the slice 

Output Inter-PFU signal FCO Slice 2 of each PFU is the fast carry chain output1

1. See Figure 2-3 for connection details. 
2. Requires two PFUs. 
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For Slices 0 and 1, memory control signals are generated from Slice 2 as follows:
         WCK is CLK
         WRE is from LSR
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Figure 2-8. Clock Divider Connections

Clock Distribution Network 
LatticeECP3 devices have eight quadrant-based primary clocks and eight secondary clock/control sources. Two 
high performance edge clocks are available on the top, left, and right edges of the device to support high speed 
interfaces. These clock sources are selected from external I/Os, the sysCLOCK PLLs, DLLs or routing. These clock 
sources are fed throughout the chip via a clock distribution system. 

Primary Clock Sources 
LatticeECP3 devices derive clocks from six primary source types: PLL outputs, DLL outputs, CLKDIV outputs, ded-
icated clock inputs, routing and SERDES Quads. LatticeECP3 devices have two to ten sysCLOCK PLLs and two 
DLLs, located on the left and right sides of the device. There are six dedicated clock inputs: two on the top side, two 
on the left side and two on the right side of the device. Figures 2-9, 2-10 and 2-11 show the primary clock sources 
for LatticeECP3 devices.

Figure 2-9. Primary Clock Sources for LatticeECP3-17
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Figure 2-20. Sources of Edge Clock (Left and Right Edges)

Figure 2-21. Sources of Edge Clock (Top Edge)

The edge clocks have low injection delay and low skew. They are used to clock the I/O registers and thus are ideal 
for creating I/O interfaces with a single clock signal and a wide data bus. They are also used for DDR Memory or 
Generic DDR interfaces.
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Figure 2-38. LatticeECP3 Banks

LatticeECP3 devices contain two types of sysI/O buffer pairs. 

1. Top (Bank 0 and Bank 1) and Bottom sysIO Buffer Pairs (Single-Ended Outputs Only)
The sysI/O buffer pairs in the top banks of the device consist of two single-ended output drivers and two sets of 
single-ended input buffers (both ratioed and referenced). One of the referenced input buffers can also be con-
figured as a differential input. Only the top edge buffers have a programmable PCI clamp.

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

The top and bottom sides are ideal for general purpose I/O, PCI, and inputs for LVDS (LVDS outputs are only 
allowed on the left and right sides). The top side can be used for the DDR3 ADDR/CMD signals. 

The I/O pins located on the top and bottom sides of the device (labeled PTxxA/B or PBxxA/B) are fully hot 
socketable. Note that the pads in Banks 3, 6 and 8 are wrapped around the corner of the device. In these 
banks, only the pads located on the top or bottom of the device are hot socketable. The top and bottom side 
pads can be identified by the Lattice Diamond tool.
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DC Electrical Characteristics
Over Recommended Operating Conditions

Symbol Parameter Condition Min. Typ. Max. Units

IIL, IIH
1, 4 Input or I/O Low Leakage 0  VIN  (VCCIO - 0.2 V) — — 10 µA

IIH
1, 3 Input or I/O High Leakage (VCCIO - 0.2 V) < VIN  3.6 V — — 150 µA

IPU I/O Active Pull-up Current 0  VIN  0.7 VCCIO –30 — –210 µA

IPD I/O Active Pull-down Current VIL (MAX)  VIN  VCCIO 30 — 210 µA

IBHLS Bus Hold Low Sustaining Current VIN = VIL (MAX) 30 — — µA

IBHHS Bus Hold High Sustaining Current VIN = 0.7 VCCIO –30 — — µA

IBHLO Bus Hold Low Overdrive Current 0  VIN  VCCIO — — 210 µA

IBHHO Bus Hold High Overdrive Current 0  VIN  VCCIO — — –210 µA

VBHT Bus Hold Trip Points 0  VIN  VIH (MAX) VIL (MAX) — VIH (MIN) V

C1 I/O Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 8 pf

C2 Dedicated Input Capacitance2 VCCIO = 3.3 V, 2.5 V, 1.8 V, 1.5 V, 1.2 V, 
VCC = 1.2 V, VIO = 0 to VIH (MAX) 

— 5 7 pf

1. Input or I/O leakage current is measured with the pin configured as an input or as an I/O with the output driver tri-stated. It is not measured 
with the output driver active. Bus maintenance circuits are disabled. 

2. TA 25 oC, f = 1.0 MHz.
3. Applicable to general purpose I/Os in top and bottom banks.
4. When used as VREF, maximum leakage= 25 µA.
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sysI/O Recommended Operating Conditions

Standard

VCCIO VREF (V)

Min. Typ. Max. Min. Typ. Max.

LVCMOS332 3.135 3.3 3.465 — — —

LVCMOS33D 3.135 3.3 3.465 — — —

LVCMOS252 2.375 2.5 2.625 — — —

LVCMOS18 1.71 1.8 1.89 — — —

LVCMOS15 1.425 1.5 1.575 — — —

LVCMOS122 1.14 1.2 1.26 — — —

LVTTL332 3.135 3.3 3.465 — — —

PCI33 3.135 3.3 3.465 — — —

SSTL153 1.43 1.5 1.57 0.68 0.75 0.9

SSTL18_I, II2 1.71 1.8 1.89 0.833 0.9 0.969

SSTL25_I, II2 2.375 2.5 2.625 1.15 1.25 1.35

SSTL33_I, II2 3.135 3.3 3.465 1.3 1.5 1.7

HSTL15_I2 1.425 1.5 1.575 0.68 0.75 0.9

HSTL18_I, II2 1.71 1.8 1.89 0.816 0.9 1.08

LVDS252 2.375 2.5 2.625 — — —

LVDS25E 2.375 2.5 2.625 — — —

MLVDS1 2.375 2.5 2.625 — — —

LVPECL331, 2 3.135 3.3 3.465 — — —

Mini LVDS 2.375 2.5 2.625 — — —

BLVDS251, 2 2.375 2.5 2.625 — — —

RSDS2 2.375 2.5 2.625 — — —

RSDSE1, 2 2.375 2.5 2.625 — — —

TRLVDS 3.14 3.3 3.47 — — —

PPLVDS 3.14/2.25 3.3/2.5 3.47/2.75 — — —

SSTL15D3 1.43 1.5 1.57 — — —

SSTL18D_I2, 3, II2, 3 1.71 1.8 1.89 — — —

SSTL25D_ I2, II2 2.375 2.5 2.625 — — —

SSTL33D_ I2, II2 3.135 3.3 3.465 — — —

HSTL15D_ I2 1.425 1.5 1.575 — — —

HSTL18D_ I2, II2 1.71 1.8 1.89 — — —

1. Inputs on chip. Outputs are implemented with the addition of external resistors.
2. For input voltage compatibility, see TN1177, LatticeECP3 sysIO Usage Guide. 
3. VREF is required when using Differential SSTL to interface to DDR memory.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
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MLVDS25
The LatticeECP3 devices support the differential MLVDS standard. This standard is emulated using complemen-
tary LVCMOS outputs in conjunction with a parallel resistor across the driver outputs. The MLVDS input standard is 
supported by the LVDS differential input buffer. The scheme shown in Figure 3-5 is one possible solution for 
MLVDS standard implementation. Resistor values in Figure 3-5 are industry standard values for 1% resistors. 

Figure 3-5. MLVDS25 (Multipoint Low Voltage Differential Signaling)

Table 3-5. MLVDS25 DC Conditions1 

Parameter Description

Typical

UnitsZo=50 Zo=70

VCCIO Output Driver Supply (+/–5%) 2.50 2.50 V

ZOUT Driver Impedance 10.00 10.00 

RS Driver Series Resistor (+/–1%) 35.00 35.00 

RTL Driver Parallel Resistor (+/–1%) 50.00 70.00 

RTR Receiver Termination (+/–1%) 50.00 70.00 

VOH Output High Voltage 1.52 1.60 V

VOL Output Low Voltage 0.98 0.90 V

VOD Output Differential Voltage 0.54 0.70 V

VCM Output Common Mode Voltage 1.25 1.25 V

IDC DC Output Current 21.74 20.00 mA

1. For input buffer, see LVDS table.
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fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data Aligned at Pin (GDDRX1_TX.SCLK.Aligned)10 

tDIBGDDR Data Invalid Before Clock ECP3-150EA — 335 — 338 — 341 ps

tDIAGDDR Data Invalid After Clock ECP3-150EA — 335 — 338 — 341 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

tDIAGDDR Data Invalid After Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-35EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-35EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-17EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-17EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX1_TX.DQS.Centered)10 

Left and Right Sides

tDVBGDDR Data Valid Before CLK ECP3-150EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-150EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

tDVAGDDR Data Valid After CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 670 — 675 — 676 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 670 — 675 — 676 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Aligned at Pin (GDDRX2_TX.Aligned)

Left and Right Sides

tDIBGDDR Data Invalid Before Clock All ECP3EA Devices — 200 — 210 — 220 ps

tDIAGDDR Data Invalid After Clock All ECP3EA Devices — 200 — 210 — 220 ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 500 — 420 — 375 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Centered at Pin  Using DQSDLL (GDDRX2_TX.DQSDLL.Centered)11

Left and Right Sides 

tDVBGDDR Data Valid Before CLK All ECP3EA Devices 400 — 400 — 431 — ps

tDVAGDDR Data Valid After CLK All ECP3EA Devices 400 — 400 — 432 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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Figure 3-11. Write Through (SP Read/Write on Port A, Input Registers Only)

Note: Input data and address are registered at the positive edge of the clock and output data appears after the positive edge of the clock.
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LatticeECP3 Family Timing Adders1, 2, 3, 4, 5, 7 
Over Recommended Commercial Operating Conditions

Buffer Type Description –8 –7 –6 Units

Input Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

LVDS25 LVDS, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 0.03 0.00 –0.04 ns

RSDS25 RSDS, VCCIO = 2.5 V 0.03 –0.01 –0.03 ns

PPLVDS Point-to-Point LVDS 0.03 –0.01 –0.03 ns

TRLVDS Transition-Reduced LVDS 0.03 0.00 –0.04 ns

Mini MLVDS Mini LVDS 0.03 –0.01 –0.03 ns

LVPECL33 LVPECL, Emulated, VCCIO = 3.3 V 0.17 0.23 0.28 ns

HSTL18_I HSTL_18 class I, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18_II HSTL_18 class II, VCCIO = 1.8 V 0.20 0.17 0.13 ns

HSTL18D_I Differential HSTL 18 class I 0.20 0.17 0.13 ns

HSTL18D_II Differential HSTL 18 class II 0.20 0.17 0.13 ns

HSTL15_I HSTL_15 class I, VCCIO = 1.5 V 0.10 0.12 0.13 ns

HSTL15D_I Differential HSTL 15 class I 0.10 0.12 0.13 ns

SSTL33_I SSTL_3 class I, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33_II SSTL_3 class II, VCCIO = 3.3 V 0.17 0.23 0.28 ns

SSTL33D_I Differential SSTL_3 class I 0.17 0.23 0.28 ns

SSTL33D_II Differential SSTL_3 class II 0.17 0.23 0.28 ns

SSTL25_I SSTL_2 class I, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25_II SSTL_2 class II, VCCIO = 2.5 V 0.12 0.14 0.16 ns

SSTL25D_I Differential SSTL_2 class I 0.12 0.14 0.16 ns

SSTL25D_II Differential SSTL_2 class II 0.12 0.14 0.16 ns

SSTL18_I SSTL_18 class I, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18_II SSTL_18 class II, VCCIO = 1.8 V 0.08 0.06 0.04 ns

SSTL18D_I Differential SSTL_18 class I 0.08 0.06 0.04 ns

SSTL18D_II Differential SSTL_18 class II 0.08 0.06 0.04 ns

SSTL15 SSTL_15, VCCIO = 1.5 V 0.087 0.059 0.032 ns

SSTL15D Differential SSTL_15 0.087 0.059 0.032 ns

LVTTL33 LVTTL, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS33 LVCMOS, VCCIO = 3.3 V 0.07 0.07 0.07 ns

LVCMOS25 LVCMOS, VCCIO = 2.5 V 0.00 0.00 0.00 ns

LVCMOS18 LVCMOS, VCCIO = 1.8 V –0.13 –0.13 –0.13 ns

LVCMOS15 LVCMOS, VCCIO = 1.5 V –0.07 –0.07 –0.07 ns

LVCMOS12 LVCMOS, VCCIO = 1.2 V –0.20 –0.19 –0.19 ns

PCI33 PCI, VCCIO = 3.3 V 0.07 0.07 0.07 ns

Output Adjusters 

LVDS25E LVDS, Emulated, VCCIO = 2.5 V 1.02 1.14 1.26 ns

LVDS25 LVDS, VCCIO = 2.5 V –0.11 –0.07 –0.03 ns

BLVDS25 BLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns

MLVDS25 MLVDS, Emulated, VCCIO = 2.5 V 1.01 1.13 1.25 ns
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Figure 3-18. XAUI Sinusoidal Jitter Tolerance Mask

Note: The sinusoidal jitter tolerance is measured with at least 0.37 UIpp of Deterministic
jitter (Dj) and the sum of Dj and Rj (random jitter) is at least 0.55 UIpp. Therefore, the 
sum of Dj, Rj and Sj (sinusoidal jitter) is at least 0.65 UIpp (Dj = 0.37, Rj = 0.18, Sj = 0.1).
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Gigabit Ethernet/Serial Rapid I/O Type 1/SGMII/CPRI LV E.12 Electrical and 
Timing Characteristics
AC and DC Characteristics
Table 3-17. Transmit

Table 3-18. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.10 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.24 UI

1. Rise and fall times measured with board trace, connector and approximately 2.5 pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 1.25 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 1.25 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 1.25 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
1, 2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.34 UI

JRX_RJ
1, 2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.26 UI

JRX_SJ
1, 2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.11 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.71 UI

TRX_EYE Receiver eye opening 0.29 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 1.25 Gbps.
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HDMI (High-Definition Multimedia Interface) Electrical and Timing 
Characteristics
AC and DC Characteristics
Table 3-22. Transmit and Receive1, 2

Symbol Description

Spec. Compliance

UnitsMin. Spec. Max. Spec.

Transmit

Intra-pair Skew — 75 ps

Inter-pair Skew — 800 ps

TMDS Differential Clock Jitter — 0.25 UI

Receive

RT Termination Resistance 40 60 Ohms

VICM
Input AC Common Mode Voltage (50-Ohm Set-
ting) — 50 mV

TMDS Clock Jitter Clock Jitter Tolerance — 0.25 UI

1. Output buffers must drive a translation device. Max. speed is 2 Gbps. If translation device does not modify rise/fall time, the maximum 
speed is 1.5 Gbps.

2. Input buffers must be AC coupled in order to support the 3.3 V common mode. Generally, HDMI inputs are terminated by an external cable 
equalizer before data/clock is forwarded to the LatticeECP3 device.
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Figure 3-24. Power-On-Reset (POR) Timing

Figure 3-25. sysCONFIG Port Timing
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Valid
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1.  Time taken from VCC, VCCAUX or VCCIO8, whichever is the last to cross the POR trip point.
2.  Device is in a Master Mode (SPI, SPIm).
3.  The CFG pins are normally static (hard wired).
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sysI/O Differential Electrical Characteristics
Transition Reduced LVDS (TRLVDS DC Specification)

Over Recommended Operating Conditions

Mini LVDS
Over Recommended Operating Conditions

Symbol Description Min. Nom. Max. Units

VCCO Driver supply voltage (+/– 5%) 3.14 3.3 3.47 V

VID Input differential voltage 150 — 1200 mV

VICM Input common mode voltage 3 — 3.265 V

VCCO Termination supply voltage 3.14 3.3 3.47 V

RT Termination resistance (off-chip) 45 50 55 Ohms

Note: LatticeECP3 only supports the TRLVDS receiver.

Parameter Symbol Description Min. Typ. Max. Units

ZO Single-ended PCB trace impedance 30 50 75 Ohms

RT Differential termination resistance 50 100 150 Ohms

VOD Output voltage, differential, |VOP - VOM| 300 — 600 mV

VOS Output voltage, common mode, |VOP + VOM|/2 1 1.2 1.4 V

VOD Change in VOD, between H and L — — 50 mV

VID Change in VOS, between H and L — — 50 mV

VTHD Input voltage, differential, |VINP - VINM| 200 — 600 mV

VCM Input voltage, common mode, |VINP + VINM|/2 0.3+(VTHD/2) — 2.1-(VTHD/2)

TR, TF Output rise and fall times, 20% to 80% — — 550 ps

TODUTY Output clock duty cycle 40 — 60 %

Note: Data is for 6 mA differential current drive. Other differential driver current options are available.

Current 
Source

VCCO = 3.3 V

Z0

RT RTTransmitter

Receiver
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[LOC]DQS[num] I/O DQ input/output pads: T (top), R (right), B (bottom), L (left), DQS, num = ball 
function number.

[LOC]DQ[num] I/O DQ input/output pads: T (top), R (right), B (bottom), L (left), DQ, associated 
DQS number.

Test and Programming (Dedicated Pins)

TMS I Test Mode Select input, used to control the 1149.1 state machine. Pull-up is 
enabled during configuration. 

TCK I Test Clock input pin, used to clock the 1149.1 state machine. No pull-up 
enabled. 

TDI I 

Test Data in pin. Used to load data into device using 1149.1 state machine. 
After power-up, this TAP port can be activated for configuration by sending 
appropriate command. (Note: once a configuration port is selected it is 
locked. Another configuration port cannot be selected until the power-up 
sequence). Pull-up is enabled during configuration. 

TDO O Output pin. Test Data Out pin used to shift data out of a device using 1149.1. 

VCCJ — Power supply pin for JTAG Test Access Port. 

Configuration Pads (Used During sysCONFIG)

CFG[2:0] I 
Mode pins used to specify configuration mode values latched on rising edge 
of INITN. During configuration, a pull-up is enabled. These are dedicated 
pins. 

INITN I/O Open Drain pin. Indicates the FPGA is ready to be configured. During config-
uration, a pull-up is enabled. It is a dedicated pin. 

PROGRAMN I Initiates configuration sequence when asserted low. This pin always has an 
active pull-up. It is a dedicated pin. 

DONE I/O Open Drain pin. Indicates that the configuration sequence is complete, and 
the startup sequence is in progress. It is a dedicated pin. 

CCLK I Input Configuration Clock for configuring an FPGA in Slave SPI, Serial, and 
CPU modes. It is a dedicated pin.

MCLK I/O Output Configuration Clock for configuring an FPGA in SPI, SPIm, and Mas-
ter configuration modes.

BUSY/SISPI O Parallel configuration mode busy indicator. SPI/SPIm mode data output. 

CSN/SN/OEN I/O Parallel configuration mode active-low chip select. Slave SPI chip select. 
Parallel burst Flash output enable.

CS1N/HOLDN/RDY I Parallel configuration mode active-low chip select. Slave SPI hold input. 

WRITEN I Write enable for parallel configuration modes.

DOUT/CSON/CSSPI1N O Serial data output. Chip select output. SPI/SPIm mode chip select.

D[0]/SPIFASTN I/O

sysCONFIG Port Data I/O for Parallel mode. Open drain during configuration.

sysCONFIG Port Data I/O for SPI or SPIm. When using the SPI or SPIm 
mode, this pin should either be tied high or low, must not be left floating. Open 
drain during configuration.

D1 I/O Parallel configuration I/O. Open drain during configuration.

D2 I/O Parallel configuration I/O. Open drain during configuration.

D3/SI I/O Parallel configuration I/O. Slave SPI data input. Open drain during configura-
tion.

D4/SO I/O Parallel configuration I/O. Slave SPI data output. Open drain during configura-
tion.

D5 I/O Parallel configuration I/O. Open drain during configuration.

D6/SPID1 I/O Parallel configuration I/O. SPI/SPIm data input. Open drain during configura-
tion.

Signal Descriptions (Cont.)
Signal Name I/O Description 
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Pin Information Summary 
Pin Information Summary ECP3-17EA ECP3-35EA ECP3-70EA

Pin Type
256 

ftBGA
328

csBGA
484 

fpBGA
256 

ftBGA
484 

fpBGA
672 

fpBGA
484 

fpBGA
672 

fpBGA
1156 

fpBGA

General Purpose 
Inputs/Outputs per Bank

Bank 0 26 20 36 26 42 48 42 60 86

Bank 1 14 10 24 14 36 36 36 48 78

Bank 2 6 7 12 6 24 24 24 34 36

Bank 3 18 12 44 16 54 59 54 59 86

Bank 6 20 11 44 18 63 61 63 67 86

Bank 7 19 26 32 19 36 42 36 48 54

Bank 8 24 24 24 24 24 24 24 24 24

General Purpose Inputs 
per Bank

Bank 0 0 0 0 0 0 0 0 0 0

Bank 1 0 0 0 0 0 0 0 0 0

Bank 2 2 2 2 2 4 4 4 8 8

Bank 3 0 0 0 2 4 4 4 12 12

Bank 6 0 0 0 2 4 4 4 12 12

Bank 7 4 4 4 4 4 4 4 8 8

Bank 8 0 0 0 0 0 0 0 0 0

General Purpose Out-
puts per Bank

Bank 0 0 0 0 0 0 0 0 0 0

Bank 1 0 0 0 0 0 0 0 0 0

Bank 2 0 0 0 0 0 0 0 0 0

Bank 3 0 0 0 0 0 0 0 0 0

Bank 6 0 0 0 0 0 0 0 0 0

Bank 7 0 0 0 0 0 0 0 0 0

Bank 8 0 0 0 0 0 0 0 0 0

Total Single-Ended User I/O 133 116 222 133 295 310 295 380 490

VCC 6 16 16 6 16 32 16 32 32

VCCAUX 4 5 8 4 8 12 8 12 16

VTT 4 7 4 4 4 4 4 4 8

VCCA 4 6 4 4 4 8 4 8 16

VCCPLL 2 2 4 2 4 4 4 4 4

VCCIO

Bank 0 2 3 2 2 2 4 2 4 4

Bank 1 2 3 2 2 2 4 2 4 4

Bank 2 2 2 2 2 2 4 2 4 4

Bank 3 2 3 2 2 2 4 2 4 4

Bank 6 2 3 2 2 2 4 2 4 4

Bank 7 2 3 2 2 2 4 2 4 4

Bank 8 1 2 2 1 2 2 2 2 2

VCCJ 1 1 1 1 1 1 1 1 1

TAP 4 4 4 4 4 4 4 4 4

GND, GNDIO 51 126 98 51 98 139 98 139 233

NC 0 0 73 0 0 96 0 0 238

Reserved1 0 0 2 0 2 2 2 2 2

SERDES 26 18 26 26 26 26 26 52 78

Miscellaneous Pins 8 8 8 8 8 8 8 8 8

Total Bonded Pins 256 328 484 256 484 672 484 672 1156
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-17EA ECP3-35EA

Pin Type 256 ftBGA 328 csBGA 484 fpBGA 256 ftBGA 484 fpBGA 672 fpBGA

Emulated Differential I/O per 
Bank

Bank 0 13 10 18 13 21 24

Bank 1 7 5 12 7 18 18

Bank 2 2 2 4 1 8 8

Bank 3 4 2 13 5 20 19

Bank 6 5 1 13 6 22 20

Bank 7 6 9 10 6 11 13

Bank 8 12 12 12 12 12 12

Highspeed Differential I/O per 
Bank

Bank 0 0 0 0 0 0 0

Bank 1 0 0 0 0 0 0

Bank 2 2 2 3 3 6 6

Bank 3 5 4 9 4 9 12

Bank 6 5 4 9 4 11 12

Bank 7 5 6 8 5 9 10

Bank 8 0 0 0 0 0 0

Total Single Ended/ Total 
Differential I/O per Bank

Bank 0 26/13 20/10 36/18 26/13 42/21 48/24

Bank 1 14/7 10/5 24/12 14/7 36/18 36/18

Bank 2 8/4 9/4 14/7 8/4 28/14 28/14

Bank 3 18/9 12/6 44/22 18/9 58/29 63/31

Bank 6 20/10 11/5 44/22 20/10 67/33 65/32

Bank 7 23/11 30/15 36/18 23/11 40/20 46/23

Bank 8 24/12 24/12 24/12 24/12 24/12 24/12

DDR Groups Bonded per 
Bank2

Bank 0 2 1 3 2 3 4

Bank 1 1 0 2 1 3 3

Bank 2 0 0 1 0 2 2

Bank 3 1 0 3 1 3 4

Bank 6 1 0 3 1 4 4

Bank 7 1 2 2 1 3 3

Configuration 
Bank 8 0 0 0 0 0 0

SERDES Quads 1 1 1 1 1 1

1. These pins must remain floating on the board.
2. Some DQS groups may not support DQS-12. Refer to the device pinout (.csv) file.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm

